
About the Request Tracker Program
Select About the Request Tracker Program from the Help menu to display a screen 
showing the program title, version number, copyright notice and the address for 
CyberNiche Software.    There is also a button that will allow you to print an order form 
for purchasing the registered version of the program.



Add Another
The Add Another button allows you to quickly add a number of new records to the 
program's database.    The Add Another button is only displayed while adding a new 
record.    Clicking on this button will save the information for the record you have just 
entered and immediately begin adding another record.    It is equivalent to clicking the 
Update button, and then clicking the Add New button again.



Adding New Request Records
Click on the Add New button to add a request to the database.    Enter information for 
all the fields you wish to track in the program by tabbing through the screen fields.    
When you have finished entering the request's information, click on the Update button. 
If you change your mind about entering the request, click on the Cancel button.

Note: The evaluation version is limited to 25 request records.    The registered version 
can have unlimited request records.



Cancel
The Cancel button is only displayed while adding a new record or modifying an existing 
record.    Click on this button if you change your mind and do not want to update the 
program's database file with the new information you have just entered.

If the Cancel button is no longer displayed, you will need to click on the Delete button to 
remove the currently displayed record.



Categories

Select Categories from the Maintain Menu to display or modify the categories 
recognized by the program.    When you first install Request Tracker, no categories will 
be defined.    You may enter any categories you like in order to group your requests.    If 
a category is associated with at least one request record, it cannot be deleted, so give 
your categories careful thought. 

The buttons at the bottom of this window behave the same way as in other parts of the 
program.    The navigation buttons may be used to move between different records,    
Find will find a specific record, Add New will add a new record and Delete will delete a 
record.    Click on Ok to close the window when you are finished.

Note: The Categories Maintenance option is unavailable while you are in the middle of 
entering a new request or updating an existing request.    Click on Update or Cancel to 
save or discard your changes, and the Categories menu option will be available once 
again.



Category

Use the Category field to record the type of request the current request record 
represents.    Select the appropriate category from the list by clicking with the mouse or 
by using the arrow keys on your keyboard.

You may define any number of categories for the program to use, based on the different 
types of requests that you handle.    Select Categories from the Maintain Menu to add or 
delete categories from this list.



Changing Fonts

Once you have entered your company name and address by selecting Maintain 
Program Defaults from the File Menu, you may change the font used when displaying or 
printing your company information. 

Select Company Name or Company Address from the Font Menu on the Maintain 
Defaults window.    You may select different font settings for these two pieces of text.    A 
standard Windows Font Window will be displayed.

You may select any font that is installed on your PC.    You may also change the font 
size and may make the text bold, italic or both.    Click on the OK button to save your 
font changes, or click on Cancel to leave the font window without making any changes 
to your company text.



Charges and Paid Status

Use these fields to track the amount of time that was spent on the request and the 
amount of money that will be charged to the customer for handling the request.    You 
may leave these fields blank if you are not interested in tracking this information.    Or 
you may enter hours and minutes to track the time spent on the request, but leave the 
monetary fields blank.    It is entirely up to you how much time you want to spend 
tracking this kind of information.

The value in the Total Cost field is calculated by the program based on the default 
charges that you specify.    Select Maintain Program Defaults from the File Menu to 
enter the default minimum charge and hourly rate to be charged for each request.    The 
program will calculate the total charge for the hours you enter multiplied by your hourly 
charge.    If this number is below the minimum charge, the minimum charge will be used 
instead.    If you enter an amount in the Additional Charge field, that amount will be 
added to whatever charge was calculated and the total will be displayed in the Total 
Cost field.    Total Cost is display only, you change this value only by changing the 
defaults as indicated above or by entering a different Additional Charge.

The Amount Paid and Payment Date fields will help you track payments made by 
customers for your services.    You may click on the Paid Today button to have the 
program fill in the total amount due in the Amount Paid field and place the current date 
in the Payment Date field, or you can enter values in these fields directly.

The charges and payment information fields are use in certain reports and in printing 
bills, but remember that the use of these fields is entirely optional.    If you do not charge 
the customers that you serve directly, you may leave all of these fields blank and just 
use the other features of the program.



Charges by Customer Report
Select Charges by Customer from the Reports Menu to generate a report of requests 
that is sorted by the name of the customer or that includes only requests for a specific 
customer.    This report lists the request date, the short description, the time spent on the 
request, the total cost and the amount paid.

On the Report Options window, click on All Customers to generate a report that 
includes requests for all customers.    To focus on a single customer, select Selected 
Customer and select a customer name from the list below.    If you choose a report for a 
selected customer, you must select a customer name from the list.

Click on OK to generate the report with your chosen options.    Click on Cancel to 
continue with other work without generating a report.



Charges by Department Report
Select Charges by Department from the Reports Menu to generate a report of requests 
that is sorted by the name of the department assigned to them or that includes only 
requests that are assigned to a specific department.    This report lists the request date, 
the short description, the time spent on the request, the total cost and the amount paid.

On the Report Options window, click on All Departments to generate a report that 
includes requests assigned to any department.    To focus on a single department, select 
Selected Department and select a department name from the list below.    If you 
choose a report for a selected department, you must select a department name from the 
list.

Click on OK to generate the report with your chosen options.    Click on Cancel to 
continue with other work without generating a report.



Company Name and Address

The Defaults Maintenance window also contains fields for you to enter your company 
name and address.    You may also include e-mail address, web site address or any 
other information in the address field (up to 255 characters). 

Note:    The company name and address is only used on bills.    If you do not plan on 
printing bills from Request Tracker, then you do not need to pay any attention to these 
fields. 
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Copyright and Disclaimer
The Request Tracker program is copyrighted 1998 by CyberNiche Software.    All 

rights reserved. It is not public domain nor free software. Non-registered users are 
granted a limited license to use the demonstration version of this product on a trial 
basis. If you intend to use Request Tracker on a regular basis, you are expected to 
register. For information on registration, see the Order Form.

A registered user is granted a single-user license to use this program on any one 
machine at any one time. A registered user is permitted to make a copy of the program 
for backup purposes only.    Distribution of the registered version of the program is not 
permitted under any conditions.    The shareware or evaluation version of the program 
may be copied and distributed without restriction as long as all the original files are 
included and are not modified in any way.

Trial Users of Request Tracker must accept this disclaimer of warranty: 
The Shareware evaluation (trial use) version is provided AS IS. The author 

makes no warranty of any kind, expressed or implied, including without limitation, any 
warranties of merchantability and/or fitness for a particular purpose. 

Registered Users of Request Tracker must accept this disclaimer of warranty:
The author warrants the physical disk(s) provided with registered versions to be 

free of defects in materials and workmanship for a period of ninety days from the date of 
registration. If the author receives notification within the warranty period of defects in 
materials or workmanship, and such notification is determined by the author to be 
correct, the author will replace the defective disk(s). 

The entire and exclusive liability and remedy for breach of this Limited Warranty 
shall be limited to replacement of defective diskette(s) and shall not include or extend to 
any claim for or right to recover any other damages, including but not limited to, loss of 
profit, data, or use of the software, or special, incidental, or consequential damages or 
other similar claims, even if the author has been specifically advised of the possibility of 
such damages.    In no event will the author's liability for any damages to you or any 
other person ever exceed the lower of suggested list price or actual price paid for the 
license to use the software, regardless of any form of the claim.    The author specifically 
disclaims all other warranties, express or implied, including but not limited to, any 
implied warranty of merchantability and/or fitness for a particular purpose.



Customer Name and Department/Company

Use these fields to store information about the person who made the request. 

Customer -- Select the name of the person initiating the request from the list in this 
field.    The names that are displayed in this field are defined in the Customer 
Maintenance screen.    Select Customers from the Maintain Menu to add new 
customers to the list.

Department/Company -- Select the name of the department or company that 
initiated the request.    Typically, this is the department or company associated with 
the customer.    The names that are displayed in this field are defined in the 
Department/Company Maintenance screen.    Select Departments from the Maintain 
Menu to add new departments or companies to the list.

Both of these fields are optional, but you will probably find it useful to track either 
customer names or the names of departments or companies that are initiating the 
requests that you handle.



Customers

Select Customers from the Maintain Menu to display or modify the customers 
recognized by the program.    Any Customers you enter here may be associated with a 
request record.    If an customer is associated with at least one request record, they 
cannot be deleted. 

The buttons at the bottom of this window behave the same way as in other parts of the 
program.    The navigation buttons may be used to move between different records,    
Find will find a specific record, Add New will add a new record and Delete will delete a 
record.    Click on Ok to close the window when you are finished.

Most of the fields on the Customers screen are self explanatory and their entry is 
optional.    The address fields are used only when printing bills.    The Alternate ID field 
may be used to store an ID number if you track your customers in a separate database. 
The Department/Company field will allow you to select a Department/Company that 
you have entered in the Departments Maintenance window.

Note: The Customers Maintenance option is unavailable while you are in the middle of 
entering a new request or updating an existing request.    Click on Update or Cancel to 
save or discard your changes, and the Customers menu option will be available once 
again.



Default Charges

Enter the hourly rate you charge for your time in the Hourly Rate field.    If there is a 
minimum charge that you impose regardless of the amount of time spent on a request, 
enter that amount in the Minimum Charge field.

Once you have entered values here, any request records that you create from that time 
on will have these charges applied to them.    When you enter the time spent working on 
a request, those hours are multiplied by the Hourly Rate you enter here to determine the 
total amount due for a request.    If that amount is below the Minimum Charge, then the 
minimum charge amount will be used for the total amount due for the request.



Deleting Request Records
Click on the Delete button to delete the record currently displayed on the screen from 
the program.    A confirmation window is displayed on the screen asking if you are sure 
you wish to delete the current record.    Click on Yes to delete the record.    Click on No 
to return to the maintenance window without deleting the current record.



Departments/Companies

Request Tracker is designed for use either by support organizations that serve separate 
companies or by support departments within large companies that support other 
departments within the same company.    The "Departments/Companies" field on the 
main request window can be used to categorize your customers or your requests any 
way you wish.

Select Departments from the Maintain Menu to display or modify the departments 
recognized by the program.    Any department or company that you enter here may be 
associated with a request record or with a customer.    If an department is associated 
with at least one request record, it cannot be deleted. 

The buttons at the bottom of this window behave the same way as in other parts of the 
program.    The navigation buttons may be used to move between different records,    
Find will find a specific record, Add New will add a new record and Delete will delete a 
record.    Click on Ok to close the window when you are finished.

Note:    the relationship between customer and department is loosely enforced.    The 
program will allow you, for example, to associate a customer with department X in the 
customer maintenance window and then create a request record for that customer that 
is associated with department Y.    This is to allow flexibility if you choose to use the 
department field for different purposes and also in recognition of the fact that people do 
sometimes shift between different departments.

Also note that the Departments Maintenance option is unavailable while you are in the 
middle of entering a new request or updating an existing request.    Click on Update or 



Cancel to save or discard your changes, and the Departments menu option will be 
available once again.



Differences Between Evaluation and Registered Versions
The evaluation version is limited to the creation of twenty five request records, while the 
registered version imposes no limits.    The registered version of Request Tracker does 
not display the registration screen that is shown as you exit from the evaluation version. 
When the registered version of the program is purchased and installed, no information 
that has already been entered in the evaluation version is overwritten.    Any request 
information that has already been entered is preserved exactly as it is.

The registered version of Request Tracker that is sent when a single copy is purchased 
is a single user version, for use on one PC.    A network version is also available that will 
allow multiple users shared access to the database over a network.    A license must be 
purchased for each PC that will be setup to run the program.    Licensing is not based on 
simultaneous users but on the number of PCs that have the ability to run the program.



Entered By and Assigned To

Both of these fields are pop down lists containing the names of your staff members as 
defined in the Staff Maintenance screen.    (Select Staff from the Maintain Menu to add 
new staff names to the lists of available names.)

Use the Entered By field to store the name of the person who first took the call or who 
entered the information into the program.    Use the Assigned To field to store the name 
of the person who actually handled the request or the person who is responsible for 
handling it. 

For both of these fields, you may either click on the downward pointing arrow to display 
the pop-down list, or you may use the arrow keys to move down through the names in 
the list.



Exit

Select Exit from the File Menu to exit from the program.    This menu option will not be 
available if you are in the process of adding or modifying a request record at the time.    
Click on the Update or Cancel buttons and you will be able to exit.



Finding a Request Record

After you have entered several request records, you may find it useful to click on the 
Find button to locate a particular request.    After you click this button, a window will 
appear where you may enter the information about the request you are trying to find.    
You may select specific request records by supplying the following information in the 
Find Window:

Search Text1 and Search Text 2 -- Enter a word or phrase in one or both of these 
fields to find a request record that contains the text you enter in the request 
description and/or the response.    If you enter text in each search field, use the And 
and Or option buttons to indicate whether a request must contain both pieces of text 
or only one.
Search In -- Select the "Request Only" or "Request and Response" option button to 
tell the program whether you want to search for the text you entered in the Request 
only or in both the Request and Response text fields.
Request Date Is -- use this section to limit the selected request by date.    Enter a 
date in the text field in this frame or click on the downward pointing arrow at the right 
to display a pop-up calendar and click on the date you want.    Then click on the 
"Less Than" or the "Greater Than or Equal To" option button to select whether you 
want to display requests that happened before or after the date you entered.
Department/Company -- Click on the downward pointing arrow and select the 
department or company whose requests you wish to display.
Assigned To -- Click on the downward pointing arrow and select the staff member 
you has been assigned the requests you wish to view.



Once you have entered information in one or more of the fields listed above, click on the 
OK button to have the program seaerch the database for matching records.    A 
message will be displayed if no matching records were found.    Matching records will be 
displayed with the most recent matching request displayed first.    Click on the Next 
button to go through the matching records one by one.

Click on the Cancel button to cancel the find operation and return to the previously 
displayed records.    Click on Display All to return to the request maintenance screen 
with the full contents of the database available for viewing.

Alternately, since the request records are sorted in descending order by request date 
(so that the newest requests appear first), you may use the navigation buttons First, 
Previous, Next and Last to move to the request record you are interested in.



Getting Help
Context sensitive help is available throughout Request Tracker.    Just press F1 from any 
window and information will be displayed on the particular part of the program that you 
are currently using.

For more detailed information, use the options on the Help menu.    Select Contents to 
display the complete listing of all topics in the help file.    Select "Search for Help on..." 
to use the standard Windows Help procedure for searching for help on a particular topic. 
Select Using Help for general information on using Help files in Windows.



Hours by Staff Report
Select Hours by Assigned Staff from the Reports Menu to generate a report of requests 
that is sorted by the name of the staff members assigned to handle them or that 
includes only requests that are assigned to a specific staff member.    This report lists 
the request date, the short description, the time spent on the request, the total cost and 
the amount paid.

On the Report Options window, click on All Employees to generate a report that 
includes requests assigned to any employee.    To focus on a single staff member, select 
Selected Employee and select a staff member from the list below.    If you choose a 
report for a selected employee, you must select a staff member name from the list.

Click on OK to generate the report with your chosen options.    Click on Cancel to 
continue with other work without generating a report.



How to Contact CyberNiche Software
You may contact CyberNiche Software by mail, by e-mail, by fax or by phone.

CyberNiche Software
4271 Carlisle Rd.
Gardners, PA 17324-8930
USA

e-mail: cniche@cniche.com

Phone/Fax: 717-486-8308

Our web site is at:    http://www.cniche.com/

We will also do custom Windows programming work at reasonable rates.



Maintain Program Defaults

Select Maintain Program Defaults from the File Menu to setup the program for your 
particular company or MIS Department.    The fields in this window affect the calculation 
of charges and the appearance of printed bills.    If you do not charge customers directly 
for the services you provide, you may ignore this section of the program.

Default Charges
Company Name and Address
Changing Fonts



Navigating Existing Records
If requests have been added to the program already, and you are not in the middle of 
adding another new request record, the navigation buttons will be available.

Click the First button to move to the very first record.    Note: if you have used the 
Find button to select records, you may be seeing only matching records (the title bar 
at the top of the main window will say "Selected Records to indicate this).    Click on 
Find again and click on the Display All Records button to display all of the request 
records entered in the program.
Click the Previous button to move to the request record immediately before the 
current record.    If the first request record is already displayed, the computer will 
beep and the first record will remain on the screen.
Click the Next button to move to the request record following the current record.    If 
the last request record is already displayed, the computer will beep and the last 
record will remain on the screen.
Click the Last button to move to the last request record in the database.



Request Tracker Order Form
To order, call or fax 717-486-8308 or select Print Topic from the File menu to print this 
order form and mail to:

CyberNiche Software 
4271 Carlisle Rd.
Gardners, PA 17324-8930

Date: ____________ Ref No:RQ100-3200

Name: ________________________________________________

Address: ______________________________________________

                                  ______________________________________________

                                  ______________________________________________

Phone:          ______________________________________________

E-Mail:          ______________________________________________

Where did you hear about the program? _______________________

What version of Windows do you use? ________________________

Registration Fee: $80.00 per copy
Shipping & Handling: $    3.00 per order
PA residents add 6% Sales Tax ($4.98 for one copy)
Outside of the US, add $1.50

*Checks must be payable in US dollars and drawn on a US Bank*

Circle one:      Visa      Mastercard      Discover/Novus      Check      Money Order

Card #: ___________________________________

Exp. Date: ___ / ___

Signature: _________________________________



Overview
Request Tracker is a Help Desk database system that allows you to store and retrieve 
all pertinent information about customer requests. Track who requests what and when 
they requested it, what was done to address the request, who handled the request and 
how much time it took them. If you charge customers for the requests you handle, 
Request Tracker will allow you to calculate charges, print bills and track payments. 

Request Tracker is easy to use -- one screen records all pertinent information about a 
single request.    Extensive search capabilities allow you to use the program's database 
to identify similar problems or requests that were handled in the past, making the 
solutions instantly available.



Printing Bills
Select Bills by Customer or Bills by Department from the Reports Menu to print bills for 
requests entered in the program.    The Report Options window will be displayed, 
allowing you to select which requests should be included on the bills.    Only requests 
that have an amount paid value less than the total cost will be included on the bills.

Depending on the report option you have chosen, you may choose whether to print bills 
for all customers by customer, for a single customer, for all departments/companies by 
department name, or for a single department.

Click on OK to generate the bills with your chosen options.    Click on Cancel to 
continue with other work without generating bills.



Priorities

Select Priorities from the Maintain Menu to display or modify the priorities recognized 
by the program.    The values that you enter here will appear in the popdown priorities 
list on the main request screen.    When you first install Request Tracker, only the 
standard priorities of "high," "medium," "low" and "Suggestion" are defined.    You may 
enter any priorities you like to customize Request Tracker for your needs.    If a priority is 
associated with at least one request record, it cannot be deleted. 

The buttons at the bottom of this window behave the same way as in other parts of the 
program.    The navigation buttons may be used to move between different records,    
Find will find a specific record, Add New will add a new record and Delete will delete a 
record.    Click on Ok to close the window when you are finished.

Note: The Priorities Maintenance option is unavailable while you are in the middle of 
entering a new request or updating an existing request.    Click on Update or Cancel to 
save or discard your changes, and the Priorities menu option will be available once 
again.



Priority

You may use this optional field to record the relative urgency of the current request.    
Select the appropriate priority from the list by clicking with the mouse or by using the 
arrow keys on your keyboard.

The program comes with "low," "medium" and "high" priorities predefined, but you can 
change these labels to suit your own needs.    Select Priorities from the Maintain Menu 
to add or delete priorities from this list.



Report Options

When you choose to generate most of the reports available in Request Tracker, a 
window of menu options will be displayed first.    This window allows you to choose 
various options to determine which request records will be included in your report:

Start and End Dates -- These dates will be set to generate a year-to-date report by 
default.    You may enter new dates to include requests for for a different time period 
in your report.    When you change these dates, the dates that you enter become the 
new defaults until you exit from the program.

Include Requests That Are... - This set of options allows you to choose whether 
you want to include requests that are currently open, requests that are resolved, or 
both open and resolved requests.    Click on the option button that indicates which 
type of requests you are interested in.

Other report options will vary depending on the report you have selected.



Report Output Window
The Report Output Window is the standard screen where all reports are displayed.    
The scroll bar on the far right will allow you to select different pages, if the report is 
longer than one page.    The Print button will print the report that is currently displayed. 
The Ok button will close the Report Output Window. 

The horizontal scroll bar at the bottom (next to the binoculars) is the zoom control.    The 
zoom control allows you to enlarge or reduce the size of the report on the screen.    
Reduce the report size in order to see an entire page on the screen at one time.    
Enlarge the report size in order to read the details of the report.    If the report is 
enlarged to a size that will not fit in the window, scroll bars will appear immediately next 
to the report text to allow you to view the entire report.

Click on the Print button to print the report that is currently displayed on the screen.    
When you have finished viewing or printing the report, click on the Ok button to close 
the Report Output window.    You will return to the main Request Maintenance window, 
where you may continue with other work.



Request Maintenance Screen

When the program is first started, the Request Maintenance window will be displayed. 
All of the data fields that describe a particular request are displayed on this screen.    
The first time the program is run, these fields will all be blank, since no request records 
will have been created yet.    Click on Add New to start entering requests in the 
program.

Buttons on this window allow you to move to different request records and Add or 
Delete request records.    The Help button will display the program documentation that 
you are now reading.



Request Number and Description

The first few fields on the program's main screen store basic descriptive information 
about the current request. 

Short Description -- Enter a brief description about the request here.    You may 
enter up to 80 characters for each request record.
Request Number -- This is a sequential number assigned by the program to each 
request.    The program will not allow you to modify this number.    This is a display 
only field.
Request Description -- You may enter a complete, detailed description of the 
current request in this field.    Words will automatically wrap to the next line as you 
type, and a scroll bar will appear if you enter more text than can be displayed at one 
time by the program.    You are limited to 64K (approximately 64 thousand 
characters) of text for each request.



Request and Due Dates

Use these fields to store the dates that the request was originally received and, if you 
wish, the date that the request must be handled by.    The request date is mandatory - 
the program will not allow you to save a new request until you have specified a request 
date.    Request records are sorted in descending order by request date (newest 
requests first) when you use the navigation buttons to move through them.

For both of these date fields, you may either enter a date with the keyboard or use the 
mouse to click on the downward pointing arrow at the right side of the date field.    A 
pop-down calendar will be displayed and you may select a date by clicking on it.



Requests by Assigned Staff Report
Select Requests by Assigned Staff from the Reports Menu to generate a report of 
requests that is sorted by the name of the staff members assigned to handle them or 
that includes only requests that are assigned to a specific staff member. 

On the Report Options window, click on All Employees to generate a report that 
includes requests assigned to any employee.    To focus on a single staff member, select 
Selected Employee and select a staff member from the list below.    If you choose a 
report for a selected employee, you must select a staff member name from the list.

Click on OK to generate the report with your chosen options.    Click on Cancel to 
continue with other work without generating a report.



Requests by Category Report
Select Requests by Category from the Reports Menu to generate a report of requests 
that is sorted by the name of the category assigned to them or that includes only 
requests that are associated with a specific category. 

On the Report Options window, click on All Categories to generate a report that 
includes requests associated with any category.    To focus on a single category, select 
Selected Category and select a category name from the list below.    If you choose a 
report for a selected category, you must select a category name from the list.

Click on OK to generate the report with your chosen options.    Click on Cancel to 
continue with other work without generating a report.



Requests by Customer Report
Select Requests by Customer from the Reports Menu to generate a report of requests 
that is sorted by the name of the customer or that includes only requests for a specific 
customer.

On the Report Options window, click on All Customers to generate a report that 
includes requests for all customers.    To focus on a single customer, select Selected 
Customer and select a customer name from the list below.    If you choose a report for a 
selected customer, you must select a customer name from the list.

Click on OK to generate the report with your chosen options.    Click on Cancel to 
continue with other work without generating a report.



Requests by Department Report
Select Requests by Department from the Reports Menu to generate a report of requests 
that is sorted by the name of the department assigned to them or that includes only 
requests that are assigned to a specific department. 

On the Report Options window, click on All Departments to generate a report that 
includes requests assigned to any department.    To focus on a single department, select 
Selected Department and select a department name from the list below.    If you 
choose a report for a selected department, you must select a department name from the 
list.

Click on OK to generate the report with your chosen options.    Click on Cancel to 
continue with other work without generating a report.



Resolved Status and Response Description

The fields in the lower left section of the main screen will store information you enter 
once the current request has been completed. 

Resolved -- Place a check mark in this field when a request is closed.    Leave the 
Resolved field unchecked to indicate that a request is still open and needs to be 
acted on.
Resolved Date -- Enter the date that the request was handled in this field.    You 
may also click on the downward pointing arrow to the right of this field to display a 
pop-down calendar from which you may select a date.
Miscellaneous -- This is a free text field that you may use for any purpose you wish. 
You may enter up to 50 characters of information in this field for each request.
Response --    You may enter a complete, detailed description of the Response 
made to the current request in this field.    Words will automatically wrap to the next 
line as you type, and a scroll bar will appear if you enter more text than can be 
displayed at one time by the program.    You are limited to 64K (approximately 64 
thousand characters) of text for each response.



Saving or Viewing Reports

The first two options on the Reports Menu allow to to choose whether reports are 
displayed with the option to print or whether the report information is saved as a text file. 
By default, reports will be displayed in a Report Output Window, where you can 
examine the different pages of the report on the screen or click on a button to print the 
report.    The first menu option ("View/Print Reports") is checked to indicate that this is 
the default setting.

Select the second Reports menu option to save the contents of reports to a text file.    
The check mark will be displayed next to this option after you select it.    When the 
"Save Report to Text File" option is checked and you run one of the reports, a standard 
Windows Save As dialogue window will be displayed.    Click on Ok to use the default 
filename that is shown, or enter an alternate name and/or folder.



Staff

Select Staff from the Maintain Menu to display or modify the staff members recognized 
by the program.    These are the people who work in your office and may receive or 
respond to requests.    The names that you enter here will appear in the pop down lists 
labeled Entered By and Assigned To on the main request screen. If an staff member is 
associated with at least one request record, they cannot be deleted. 

The buttons at the bottom of this window behave the same way as in other parts of the 
program.    The navigation buttons may be used to move between different records,    
Find will find a specific record, Add New will add a new record and Delete will delete a 
record.    Click on Ok to close the window when you are finished.

Most of the fields on the Staff screen are self explanatory and their entry is optional.    
The Alternate ID field may be used to store an ID number if you track your staff in a 
separate database. 

Note: The Staff Maintenance option is unavailable while you are in the middle of 
entering a new request or updating an existing request.    Click on Update or Cancel to 
save or discard your changes, and the Staff menu option will be available once again.



Support Policy
While we try to test our products as thoroughly as possible, occasionally something may 
escape our notice.    We want you to know that we stand behind our products.    If you 
experience a problem with this program, we do want to know about it.    Send us an e-
mail message, write or call to let us know what has gone wrong and we'll do everything 
we can to help resolve the problem. 



Update
The Update button is displayed only when adding a new record or modifying an existing 
record.    Clicking Update will save the newly entered or changed request record to the 
program's database file and allow you to continue with other work.






